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  FORMATTING 

PASTE PARAGRAPHS OF TEXT INTO A SINGLE CELL IN MICROSOFT EXCEL�

If you have text that is in a text program e.g. Microsoft Word, and would like to copy and paste it to Microsoft Excel, by 
default Microsoft Excel separates the information into different cells based on the paragraph marks. 

In Microsoft Word 

 

Pasted into Microsoft Excel 

 

By using the below method, you are able to paste the text into a single cell in Microsoft Excel.  

Pasted into Microsoft Excel using F2 

 

Microsoft Excel 2003/2007 process: 

1. Copy  the desired text  from the text  program (Microsoft Word) 
2. Select the desired cell in Microsoft  Excel  
3. Press F3 on the keyboard 
4. Select Paste 
5. Press Enter  
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FORMATTING YOUR DATES TO SHOW THE PERIOD NUMBER 

By using a Custom Format, you can show the period of the date (in this case the month) without changing the date in the 
field. 

Before (dates in March 2007):  After (using a Custom Format):  

  

Microsoft Excel 2003/2007 process: 

1. Select the desired cell/cells  
2. Right  click on the selected cell/cells 
3. Select Format  Cells  
4. Under Category , select Custom  
5. In the Type box, enter m 

 

 
 

6. Select OK 
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DISPLAYING VALUES THAT ARE IN MILLIONS AS THOUSANDS E.G. 300,364 AS 300 
Sometimes every figure in a spreadsheet will be in the thousands, tens of thousands or even in the millions. By rounding 
the figure to smaller, representative figures you can save space. 

Before : After : 

  

 

Microsoft Excel 2003/2007 process: 

1. Select the desired range (B2:B10) 
2. Right  click on the selected range  
3. Select Format  Cells  
4. From the Category  List , select Custom  
5. In the Type box, enter 0, as below: 

 

 
 

6. Select OK 
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CONVERTING NEGATIVE NUMBERS TO POSITIVE VALUES  
This tip will allow you to quickly convert a range of negative numbers into positive numbers, without having to edit each 
cell. 

Before : After : 

  

Microsoft Excel 2003/2007 process: 

1. In a blank  cell, enter in the value -1 (C1) 
2. Select the cell with the value -1 
3. Select Copy  
4. Select the desired range with negative  values (A2:A5) 
5. Right  click on the selected  range 
6. Select Paste Special  
7. Under the Operation  group, select Multiply 

 

 
 

8. Select OK 
9. Your values  are now converted  to positive  values 
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CLEARING A RANGE OF CELLS QUICKLY  

Believe it or not, you can do it by dragging the fill handle backwards. 

Microsoft Excel 2003/2007 process:   

1. Select a range of empty  cells (A11:C11) 
2. Select the Fill  Handle 

 

 
 

3. Drag  it back over the area you would like to clear (A10:C2) 
4. If you also want to clear  the formats  in the cells, just hold down the Ctrl  key as you drag the fill handle back over 

the selection 
�
�
�
�
�
�
�
�

Fill Handle 
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KEEPING 00 IN FRONT OF VALUES E .G. 2 MUST APPEAR 002�

Using a custom format will allow you to keep the full number and not lose any leading zeros. 

Before : After : 

  

Microsoft Excel 2003/2007 process: 

1. Select  the desired cells  (B2:B10) 
2. Right  click on the selected  cells 
3. Select Format  Cells  
4. Select the Number  tab 
5. Select Custom  
6. In the Type box, enter 000 

 

 
 

7. Select OK 
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COPY FORMULAS AND FORMATTING ACROSS COLUMNS 

It’s easy to copy formulas and formatting across row of subtotals, for example, to other sub groups. In this example we will 
use the totals formula and formatting  from rows 6, 12 and 18 and quickly copy  them across to column E. 

Example 

 

Microsoft Excel 2003/2007 process: 

1. Select cell B6 and apply the desired formula  =SUM(B7:B11) 
2. Apply the necessary formatting  (Currency style, zero decimal places) 
3. Select cell B12 and apply the desired formula  =SUM(B13:B17) 
4. Using the Format  Painter   to copy the formatting from cell B6 

 
5. Select cell B18 and apply the desired formula  =SUM(B19:B21) 
6. Using the Format  Painter  to copy the formatting from cell B6 

 
7. Select cell B6 and drag the Autofill  through to E6 
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8. Select cell B12 and press F4 
9. Your formula  and formatting  will be copied  across to column E 
10. Select cell B18 and press F4 
11. Your formula  and formatting  will be copied across to column E 
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PIVOTTABLES 

CUSTOMISING SORT OPTIONS IN A PIVOTTABLE  
Adding your own custom sort options can make your PivotTable even easier to read. 

Microsoft Excel 2003 process:  

1. Select any cell  in the column  you would like to sort  in the PivotTable  
2. From the Menu bar, select Data, Sort  
3. Select Options 

 

 
 

4. From the drop  down  arrow, select the sort  order  e.g. Jan, Feb, Mar… 
 

 
 

5. Select OK 
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Microsoft Excel 2007 process: 

1. Select any cell  in the column  you would like to sort  in the PivotTable  
2. From the Home tab, in the Editing  group, select Sort & Filter  
3. Select Custom  Sort  
4. Select More Options 

 

 
 

5. De-select, Sort automatically every…  
6. From the drop  down  arrow, select the sort  order  e.g. Jan, Feb, Mar… 

 

 
 

7. Select OK 
 

 
 
 
GROUPING DATA IN A PIVOTTABLE BY DAYS OF THE WEEK  

 
Extending PivotTable functionality even further, data can be grouped into preset categories such as days of the week. 
 

In the PivotTable  options  dialogue box, under the Tools & Filters  tab, you can select Use 
Custom List when sorting . 

This will ensure that your PivotTable  will by default  use the Custom  List . 
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Microsoft Excel 2003 process:   

1. Right  click on the Date field in the PivotTable  
2. Select Group  and Show Detail  
3. Select Group  
4. Under By, select Days 
5. Next to Number  of Days, select 7 
6. Select OK 

 

 
 

Result: 

 

 

 

Microsoft Excel 2007 process: 

1. Select the Date field in the PivotTable  
2. From the Options  tab, in the Group  group, select the Group  Selection  button 
3. Under By, select Days 
4. Next to Number  of Days, select 7 

�����

��
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5. Select OK 

 

 
 

Result: 

 

 

�����
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Filtering Values In A PivotTable �
If you do not want to show all the 0 values in your PivotTable, apply an AutoFilter . 

Microsoft Excel 2003 process: 

1. Select the cell  to the right  of the last  heading on the PivotTable 
 

 
 

2. From the Menu bar, select Data, Filter , AutoFilter  
3. Select the drop  down  arrow from the Value heading e.g. Sum of Product Sale 

 

 
 

4. Select Custom  
5. Select the below: 

 

 
 

6. Select OK 
 

 

�������
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Microsoft Excel 2007 process: 

1. Select the cell  to the right  of the last  heading on the PivotTable 
 

 
 

2. From the Data tab, in the Sort & Filter  group, select Filter  
3. Select the drop  down  arrow from the Value heading e.g. Sum of Product Sale 

 

 
 

4. De-select 0 
5. Select OK 

 

 

De-select 0 
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SHORTCUTS 

SELECTING A COLUMN WITH ONLY TWO KEYSTROKES�

Microsoft Excel 2003/2007 process: 

1. Select any cell in the column you would like to select 
2. Press Ctrl  + Space Bar 

 

SELECTING A ROW WITH ONLY TWO KEYSTROKES 
Microsoft Excel 2003/2007 process:   

1. Select any cell in the row you would like to select 
2. Press Shift  + Space Bar 

 

WRAPPING TEXT IN A CELL  
Microsoft Excel 2003/2007 process:  

1. Enter in the desired text 
 

 
 

2. Press Alt + Enter  
3. Press Enter 
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NAMING A RANGE OF CELLS  
A range of cells can be given a Name, which can then be used in place of the actual cell references in other formulae. 

Microsoft Excel 2003 process:  

1. Select the desired  range of cells 
 

 
 

2. On the keyboard, press Ctrl + F3 
3. In the Names in  workbook  box, enter in the desired Named Range 
4. In the Refers  to  box , ensure you have the correct range   

 

 
 

5. Select OK 
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Microsoft Excel 2007 process:  

1. Select the desired  range of cells 
 

 
 

2. On the keyboard, press Ctrl + F3 
3. Select New 

 

 
 

4. In the Name box, enter in the desired Named Range 
5. In the Scope  box, select where you would like the Named Range to be available   
6. In the Refers  to  box, ensure you have the correct range 

 

 
 

7. Select OK, Close 
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QUICKLY ACCESSING A LIST OF NAMED RANGES 
Once you have named the ranges in your Microsoft Excel worksheet, you may need to use them in such things as 
Formulae, Data Validation or Pasting a List. By pasting a list, you will get a list of the Named Ranges and which cells they 
refer to. 

Microsoft Excel 2003/2007 process:  

1. To use in a Function : 
a. Once you are at the desired point  in the function  (VLOOKUP – Table_array) 
b. Press F3 
c. Select the desired Named Range 

 

 
 

d. Select OK 
2. To use in Data Validation : 

a. Once you are at the desired point  in the data validation  e.g. Source dialogue box 
b. Press F3 
c. Select the desired Named Range 

 

 
 

d. Select OK 
3. To Paste a List  on Named Ranges : 
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a. Select a cell  in the worksheet  where you would like the list  to be pasted 
b. Press F3 

 

 
 

c. Select Paste List  
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KEYBOARD SHORTCUT TO CREATE A CHART 
By using one keystroke, you can create a chart without going through the Chart Wizard process. 

Microsoft Excel 2003/2007 process:   

1. Select the range  you would like to Chart  
2. Press F11 on the keyboard 
3. A new worksheet will be inserted with the Chart  

 

INSERT DATE SHORTCUT 

Rather than typing out the date in a cell, you can use a keyboard shortcut to insert the current date instantly. 

Microsoft Excel 2003/2007 process: 

1. Select the cell  you would like to enter  the date 
2. Hold down the Ctrl  button and then press ; (Semi colon) on the keyboard 

 

FILL RANGE SHORTCUT 
There are a few ways to fill a range of text or a formula. This tip will show you how to firstly select the range to be filled, 
enter the desired text or formula once, then use a keystroke combination to copy it to all cells in the highlighted range.  

Microsoft Excel 2003/2007 process: 

1. Select the range  of cells to be filled 
 

 
 

2. Enter in the desired text  or formula  into the cell 
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3. Press Ctrl + Enter 
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MACROS 

SORTING WORKSHEETS IN ALPHABETICAL ORDER 
With the following Visual Basic macro, called SortSheets, added to your workbook, you can order the worksheets 
alphabetically quickly and easily. 

Visual Basic Coding: 

Sub SortSheets()  
Dim sCount As Integer, K As Integer, L As Integer  
Application.ScreenUpdating = False  
sCount = Worksheets.Count  
If sCount = 1 Then Exit Sub  
For K = 1 To sCount - 1  
For L = K + 1 To sCount  
If Worksheets(L).Name < Worksheets(K).Name Then  
Worksheets(L).Move Before:=Worksheets(K)  
End If  
Next L  
Next K  
End Sub 

Microsoft Excel 2003 Process:   

To Insert the Coding 

1. From the Menu bar, select Tools , Macros, Visual Basic Editor  
2. Select the Module  you would like to insert the coding into 

 

 
 

3. On the right  hand side paste  the below coding 
4. From the Menu bar, select File, Close  and Return  to Microsoft Excel  

 

Run the Macro 

1. From the Menu bar, select Tools , Macros , Macros  
2. Select SortSheets  
3. Select Run 
 

Microsoft Excel 2007 Process:  

Activate the Developer tab (if not already turned o n) 
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1. Select the Office  button 

 

  
 

2. Select Excel  Options  
3. Select Show Developer tab in the Ribbon 

 

 
 

To Insert the Coding 

1. From the Developer  tab in the Code group, select Visual Basic  
2. Select the Module  you would like to insert the coding into 

 

 
 

3. On the right  hand side paste  the below coding  
4. From the Menu bar, select File, Close and Return to Microsoft Excel  

Run the Macro 

1. From the View tab, in the Macros  group, select Macros  
2. Select SortSheets  
3. Select Run 
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OPENING A WORKBOOK ON A SPECIFIC SHEET 
The following code will allow you to specify which worksheet, even to which cell, you would like to appear when the 
workbook opens. 

Visual Basic Coding: 

Private Sub Workbook_Open() 
Sheets("Sheet1").Select 
Range("a1").Select 
End Sub 

Microsoft Excel 2003/2007 process: 

1. Open Microsoft  Excel  
2. Press Alt + F11 
3. This will open the VISUAL BASIC Editor  
4. On the far left , under Microsoft Excel Object , select ThisWorkbook  
5. On the right hand side, paste the below coding 

 

 
 
 

6. In the second line of the coding, change Sheet1, to the sheet name (tab) you wish to land on 
7. In the third line of the coding, change A1, to the cell you wish to land on 
8. From the Menu bar, select File, Close and Return to Microsoft Excel  
9. Save and close  the Microsoft  Excel  workbook 

 
If using Microsoft  Excel  2007, ensure you save the workbook as a *.xlsm 
 

10. The next time you open the workbook, it will open on the specific worksheet and cell 
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COPY AND SAVE A WORKSHEET INTO A NEW FILE AUTOMATICALLY  
By using the following code, you can automatically copy the current worksheet to a new workbook, then automatically 
save the workbook using the contents of a cell as the file name. 

Note 

�  The below Macro is written to take the data from cell A1 and use it as the file name 
�  The below Macro is writing to automatically save the workbook in C:\My Documents  
�   If you do not have this directory, the Macro will give an error 

Visual Basic Coding: 

Public Sub SaveWorksheet() 

ActiveSheet.Copy ' Copies active sheet to a new workbook 

ActiveWorkbook.SaveAs "C:\My Documents\" & Range("A1").Value 

End Sub 

Microsoft Excel 2003/2007 process: 

1. Ensure you are in Microsoft  Excel  
2. Press ALT + F11 to open the Visual Basic Editor  
3. If necessary, Insert  a Module  

a. Excel 2003 - From the VBAProject (Personal.xls ), select the Module  folder 
b. From the Menu, select Insert , Module  
c. Excel 2007 – From the VBAProject (Personal.xlsb ), select the Module  folder 
d. From the Menu, select Insert , Module  

4. On the right  hand side, paste  the above coding 
 

 
 

5. From the Menu bar, select File, Close  and Return to Microsoft Excel  
6. Enter in the necessary data into cell A1 
7. Run the Macro  
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REMOVING EMBEDDED HYPERLINKS WITH VISUAL BASIC 

Sometimes a copy  and paste  of Internet based materials can also bring across embedded hyperlinks . The following 
code will to remove all  hyperlinks from the worksheet . 

Visual Basic Coding:  

Sub RemoveHyperlinks()  
'Remove all hyperlinks from the active sheet  
ActiveSheet.Hyperlinks.Delete  
End Sub 

Microsoft Excel 2003/2007 process: 

1. Ensure you are on the worksheet  you would like to remove  the hyperlinks from 
2. Press ALT + F11 to open the Visual  Basic  Editor 
3. From the Menu bar, select Insert  Module 
4. Copy  and paste  the below coding  into the Window  on the right 

 

 
 
 

5. From the Menu bar, select File, Close  and Return  to Microsoft  Excel  
6. Press ALT + F8 to view a list of Macros  
7. Select the Macro , RemoveHyperlinks 

 

���	���
��
������������
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8. Select Run 

 

 

MACRO SECURITY LEVELS 

Have you ever received this message or a similar message in Microsoft Excel?  

 

This message is displayed when the Macro security settings are set to block all macros. The following steps will solve the 
problem. 

Microsoft Excel 2003 process: 

Set Security Level 

1. From the Menu bar, select Tools , Macros , Security  
2. Select Medium  
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3. Select OK 
4. Close  Microsoft Excel and open again for this setting to take effect 

 

Enable Macros 

1. When you open  a workbook with a Macro  you will get the below message 
 

 
 

2. Select Enable  Macros  
 

Microsoft Excel 2007 process: 

Set Security Level 

1. Select the Microsoft  Office  button 
 

 
 

2. Select Excel  Options 
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3. On the left, select Trust  Center  
4. Select Trust  Center  Settings 

 

 
 

5. On the left , select Macro  Settings  
6. Select Disable all macros with notification 

 

 
 

7. Select OK 
 

Enable Macros 

1. When you open a workbook  with a Macro  you will get the below message 
 



�
�

�

 
 

2. Select Options  
3. Select Enable this content 

 

 
 

4. Select OK 
 

�

GROUPING PROTECTED WORKSHEETS 
The Group and Outline tool is a fantastic utility, however you cannot, by default, apply grouping to protected worksheets. 
The following code will help you get around this 

 

Note 

If you would like to apply the Visual Basic coding, simply copy the coding highlighted in blue and adjust the worksheet 
name 

Group and 
Outline 
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Visual Basic Coding: 

Option Explicit 
Sub auto_open() 
With Worksheets("January") 
.Protect Password:="hi", userinterfaceonly:=True 
.EnableOutlining = True 
'.EnableAutoFilter = True 
End With 
With Worksheets("February") 
.Protect Password:="hi", userinterfaceonly:=True 
.EnableOutlining = True 
'.EnableAutoFilter = True 
End With 

End Sub 

Microsoft Excel 2003/2007 process: 

You are going to add some simple VISUAL BASIC coding into the workbook. This code has the password "hi" built in, so it 
will be automatically protected. You can change the password in the below script if you wish. When the user opens the 
workbook, they will need to select, "Enable Macros".  

For this example we are going to say that the workbook name is Report and the worksheet name is January. 

1. Open the desired workbook  
2. Press Alt + F11 to open the Visual Basic Editor window 
3. On the left  you should see your Project  (with your file name e.g. VBAProjectReport) 
4. Right  click on the Project  and select Insert , Module  
5. A folder called modules should appear with a Module  underneath 
6. Select the Module 1  and on the right  hand side, paste  the below coding  
7. Remember to change  the worksheet  name and password   
8. Close  the Microsoft Visual Basic window (File, Close and Return to Microsoft Excel) 
9. Close  the workbook  and re-open  
10. You should be asked to Enable Macros  
11. Your workbook should still be protected but you should be able to use your grouping 
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CONVERTING A VALUE INTO WORDS 
By using some Visual Basic code in your worksheet module, you’ll then have access to your own SPELLNUMBER() 
function. This function will put a value that is in a cell, into words. 

 

Visual Basic Coding: 

Option Explicit 

'Main Function 

Function SpellNumber(ByVal MyNumber) 

    Dim Rands, Cents, Temp 

    Dim DecimalPlace, Count 

    ReDim Place(9) As String 

    Place(2) = " Thousand " 

    Place(3) = " Million " 

    Place(4) = " Billion " 

    Place(5) = " Trillion " 

    ' String representation of amount. 

    MyNumber = Trim(Str(MyNumber)) 

    ' Position of decimal place 0 if none. 

    DecimalPlace = InStr(MyNumber, ".") 

    ' Convert cents and set MyNumber to dollar amount. 

    If DecimalPlace > 0 Then 

        Cents = GetTens(Left(Mid(MyNumber, DecimalPlace + 1) & _ 

                  "00", 2)) 

        MyNumber = Trim(Left(MyNumber, DecimalPlace - 1)) 

    End If 

    Count = 1 

    Do While MyNumber <> "" 

        Temp = GetHundreds(Right(MyNumber, 3)) 
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        If Temp <> "" Then Rands = Temp & Place(Count) & Rands 

        If Len(MyNumber) > 3 Then 

            MyNumber = Left(MyNumber, Len(MyNumber) - 3) 

        Else 

            MyNumber = "" 

        End If 

        Count = Count + 1 

    Loop 

    Select Case Rands 

        Case "" 

            Rands = "No Rands" 

        Case "One" 

            Rands = "One Dollar" 

         Case Else 

            Rands = Rands & " Rands" 

    End Select 

    Select Case Cents 

        Case "" 

            Cents = " and No Cents" 

        Case "One" 

            Cents = " and One Cent" 

              Case Else 

            Cents = " and " & Cents & " Cents" 

    End Select 

    SpellNumber = Rands & Cents 

End Function 

       

' Converts a number from 100-999 into text 

Function GetHundreds(ByVal MyNumber) 
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    Dim Result As String 

    If Val(MyNumber) = 0 Then Exit Function 

    MyNumber = Right("000" & MyNumber, 3) 

    ' Convert the hundreds place. 

    If Mid(MyNumber, 1, 1) <> "0" Then 

        Result = GetDigit(Mid(MyNumber, 1, 1)) & " Hundred " 

    End If 

    ' Convert the tens and ones place. 

    If Mid(MyNumber, 2, 1) <> "0" Then 

        Result = Result & GetTens(Mid(MyNumber, 2)) 

    Else 

        Result = Result & GetDigit(Mid(MyNumber, 3)) 

    End If 

    GetHundreds = Result 

End Function 

       

' Converts a number from 10 to 99 into text. 

Function GetTens(TensText) 

    Dim Result As String 

    Result = ""           ' Null out the temporary function value. 

    If Val(Left(TensText, 1)) = 1 Then   ' If value between 10-19... 

        Select Case Val(TensText) 

            Case 10: Result = "Ten" 

            Case 11: Result = "Eleven" 

            Case 12: Result = "Twelve" 

            Case 13: Result = "Thirteen" 

            Case 14: Result = "Fourteen" 

            Case 15: Result = "Fifteen" 

            Case 16: Result = "Sixteen" 
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            Case 17: Result = "Seventeen" 

            Case 18: Result = "Eighteen" 

            Case 19: Result = "Nineteen" 

            Case Else 

        End Select 

    Else                                 ' If value between 20-99... 

        Select Case Val(Left(TensText, 1)) 

            Case 2: Result = "Twenty " 

            Case 3: Result = "Thirty " 

            Case 4: Result = "Forty " 

            Case 5: Result = "Fifty " 

            Case 6: Result = "Sixty " 

            Case 7: Result = "Seventy " 

            Case 8: Result = "Eighty " 

            Case 9: Result = "Ninety " 

            Case Else 

        End Select 

        Result = Result & GetDigit _ 

            (Right(TensText, 1))  ' Retrieve ones place. 

    End If 

    GetTens = Result 

End Function 

     ' Converts a number from 1 to 9 into text. 

Function GetDigit(Digit) 

    Select Case Val(Digit) 

        Case 1: GetDigit = "One" 

        Case 2: GetDigit = "Two" 

        Case 3: GetDigit = "Three" 

        Case 4: GetDigit = "Four" 
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        Case 5: GetDigit = "Five" 

        Case 6: GetDigit = "Six" 

        Case 7: GetDigit = "Seven" 

        Case 8: GetDigit = "Eight" 

        Case 9: GetDigit = "Nine" 

        Case Else: GetDigit = "" 

    End Select 

End Function 

Microsoft Excel 2003 process:  

Insert the coding  

1. From the Menu bar, select Tools , Macros, Visual Basic Editor  
2. Select the Module  you would like to insert the coding into 

 

 
 

3. On the right  hand side paste  the below coding 
4. From the Menu bar, select File, Close  and Return  to Microsoft Excel  

 

Insert the Function 

1. Select the Insert Function  dialogue box 
 

 
 

2. Select the category User Defined 
 

 
 

3. Select SpellNumber  
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4. Select the cell that contains the value, select OK 
 

Microsoft Excel 2007 process: 

Activate the Developer tab 

1. Select the Office  button 
 

  
 

2. Select Excel  Options  
3. Select Show Developer tab in the Ribbon 

 

 
 

Insert the coding  

1. From the Developer  tab in the Code group, select Visual Basic  
2. Select the Module  you would like to insert the coding into 

 

 
 

3. On the right  hand side paste  the below coding  
4. From the Menu bar, select File, Close and Return to Microsoft Excel  

 

Insert the Function 

1. Select the Insert Function  dialogue box 
 

 
 

2. Select the category User Defined 
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3. Select SpellNumber  
4. Select the cell that contains the value 
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TRACK CELL EDITING 
You can use the Worksheet_Change event to write a handler that will record when any particular cell in a worksheet is 
changed. The macro simply puts the cell address of the last change cell into the status bar. 

Microsoft Excel 2003/2007 process: 

1. Open Microsoft  Excel  
2. Right  click on the desired worksheet  tab/name 
3. Select View Code 
4. Paste the below coding  on to the desired sheet  module e.g. Sheet1 (Sheet1) 
5. Depending on which sheet  module you select , will depend  on which worksheet  will have this functionality   

 

 

 

6. Select File, Close and Return to Microsoft Excel  
7. Ensure you are on the correct  worksheet 
8. Select the desired cell  on the worksheet  
9. Enter  in the data 
10. On the Status  bar (bottom left) you will see the cell reference  that has been changed e.g &A&2 
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FORMULAE 

FORMULA AUDITING – SHOWING CELL DEPENDENCIES 
Some spreadsheets can get very complicated, with many cells relying on other cell calculations to deliver information and 
a change of one cell can have dramatic effects. Formula Auditing will show you which cells are connected. 

Microsoft Excel 2003 process: 

1. To activate the Formula  Auditing  toolbar 
a. Select the desired cell  
b. From the Menu bar, select View, Toolbars , Formula  Auditing  

2. To trace all cells dependant : 
a. Select the desired cell  
b. From the Formula  Auditing  toolbar, select Trace Dependants  

3. To trace all cells that are preceding : 
a. Select the desired cell  
b. From the Formula  Auditing  toolbar, select Trace Precedents   
c. If the Preceding  cells are found on another worksheet, you will get a dotted  line 
d. Double  click on the dotted  line, select the reference , select OK 

4. To remove all the arrows : 
a. Select the desired cell  
b. From the Formula  Auditing  toolbar, select Remove All Arrows  

 

 

 

 

 

Dependants 

Dotted Line 
Precedence 

Trace 
Dependants 

Trace 
Precedents 

Remove all 
Arrows 
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Microsoft Excel 2007 process: 

1. To trace  all cells that are preceding : 
a. Select the desired cell  
b. From the Formulas  tab, in the Formula  Auditing  group, select  Trace Precedents  
c. If the Precedent  cells are found on another worksheet, you will get a dotted line 
d. Double  click on the dotted  line, select the reference , select OK 

2. To trace all cells dependant : 
a. Select the desired cell  
b. From the Formulas  tab, in the Formula  Auditing  group, select  Trace Dependents  

3. To remove  all the arrows : 
a. Select the desired cell  
b. From the Formulas  tab, in the Formula  Auditing  group, select  Remove  Arrows  

 

 
Dependants 

Dotted Line 
Precedence 

Trace 
Dependants 

Trace 
Precedents 

Remove all 
Arrows 
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FINDING THE CELL WITH THE HIGHEST VALUE IN A RANGE 

At times you may be working with data where you need to find the maximum value. To do this, you can sort  or use the 
MAX function.  You may however, might not want to sort the column and are looking for the MAX value, but would like to 
know the cell  address  that contains the maximum  value. 

Example 

 
 

MATCH MATCH(lookup_value,lookup_array,match_type) 

The MATCH function will return the row number of the highest value. 

Lookup_value  :   

Is the value you use to find the value you want in a table. Lookup_value can be a value (number, text, or 
logical value) or a cell reference to a number, text, or logical value. 

Lookup_array  :   

Is a contiguous range of cells containing possible lookup values.  

Match_type  :  

Is the number -1, 0, or 1. Match_type specifies how Microsoft Excel matches lookup_value with values in 
lookup_array. 

If match_type is 0, MATCH finds the first value that is exactly equal to lookup_value. Lookup_array can 
be in any order. 
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ADDRESS ADDRESS(row_num,column_num,abs_num,a1,sheet_text) 

The ADDRESS function will return the cell address of the highest value. 

Row_num  :        

Is the row number to use in the cell reference. 

Column_num  :  

Is the column number to use in the cell reference. 

Abs_num  :        

Specifies the type of reference to return. 1 - Absolute, 2 - Absolute row; relative column, 3 
Relative row; absolute column, 4 - Relative 

MAX MAX(number1,number2,...) 

Number1, number2  :   

Are 1 to 255 numbers for which you want to find the maximum value. 

 

Microsoft Excel 2003/2007 process: 

1. Open Microsoft  Excel  
2. Select the desired result  cell 
3. Select the Insert  Function  button on the Formula  bar 

 

 
 

4. In the Row_num  box, enter in the below: 
 
MATCH(MAX(“Column to calculate max”),”Column to find the max, finds the first value that is exactly equal) 
 

5. In the Column_num  box, enter the below: 
 
4 – You want to use column D (4) as the result reference 
 

6. In the Abs_num  box, enter the below: 
 
4 – You would like a relative reference 
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7. Select OK 
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ROUNDING NUMBERS TO THE NEAREST WHOLE NUMBER (E.G. TENS, HUNDREDS OR 

THOUSANDS) 

Using the ROUND function, you can round a number upwards to the nearest hundred, thousand, million or higher. 

Example 

The Rounded Up  column is rounding the values up the nearest hundredth. 

 

ROUND ROUND(number,num_digits) 

Number  : 

Is the number you want to round. 

Num_digits  :    

Specifies the number of digits to which you want to round number. 
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Microsoft Excel 2003/2007 process: 

1. Select the desired  cell (D2) 
2. Enter in the below formula : 

 
=ROUND(C2,-2) 
 

3. Press Enter 
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DELETING ALL NON -FORMULA DATA ON A WORKSHEET  

Have you ever found that at the beginning of the Financial Year you need to make a copy of the previous year’s 
workbook? If so, you’d need to delete all the old year’s data but you would really like to keep all of the formulae in the 
worksheet. By using the Go To dialogue box, it is a quick any easy method. 

Microsoft Excel 2003/2007 process: 

1. Make a copy  of the desired worksheet 
2. Press F5 on the keyboard (The Go To dialogue box will pop up) 
3. Select Special 
4. Select Constants 

 

 
 

5. Select OK 
6. All cells containing constants (everything except formulae) will be selected 
7. Press Delete on the keyboard 

Constants 
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FILTER DATE TRANSACTIONS TO SHOW ONLY DATES THAT FAL L BETWEEN A RANGE (E.G. 30 

AND 60 DAYS) 

By using a combination of the TODAY and AND function, you can determine whether a date falls inside of a particular 
date range.  

Example 

 

This result will give you an answer of either True or False which you can then filter or use in combination with another 
function. This can be a handy when used in combination with a SUMIF to calculate transactions in certain date range.  

TODAY TODAY( ) 

Returns the serial number of the current date. The serial number is the date-time code used by Microsoft 
Excel for date and time calculations. If the cell format was General before the function was entered, the 
result is formatted as a date. 

AND AND(logical1,logical2, ...) 

Logical1, logical2 , ... :     

Are 1 to 255 conditions you want to test that can be either TRUE or FALSE. 
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Microsoft Excel 2003/2007 process: 

1. Select the desired cell 
2. Enter in the formula  

 
=AND(TODAY()-B3>=30,TODAY()-B3<=60) 
 

3. Copy  the formula down 
4. Use Filtering  to Filter  all values that are TRUE 
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 CONVERTING TEXT DATES TO DATES 

Occasionally, dates may become formatted and stored in cells as text. For example, you may have entered a date in a 
cell that was formatted as text, or the data might have been imported or pasted from an external data source as text. 

Dates that are formatted as text are left-aligned instead of right-aligned in a cell. You can use the DATEVALUE function to 
convert most other types of text dates to dates. 

DATEVALUE  DATEVALUE(date_text) 

Date_text  : 

Is text that represents a date in a Microsoft Excel date format. For example, "1/30/2008" or "30-Jan-
2008" are text strings within quotation marks that represent dates. Using the default date system in 
Excel for Windows, date_text must represent a date from January 1, 1900, to December 31, 9999. 
Using the default date system in Microsoft Excel for the Macintosh, date_text must represent a date 
from January 1, 1904, to December 31, 9999. DATEVALUE returns the #VALUE! error value if date_text 
is out of this range. 

If the year portion of date_text is omitted, DATEVALUE uses the current year from your computer's built-
in clock. Time information in date_text is ignored. 
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Microsoft Excel 2003/2007 process:  

1. Select the desired  cell (B2) 
2. Enter the below function: 

 
 =DATEVALUE(A2)  
 
The DATEVALUE function returns the serial number of the date that is represented by the text date 
 

 
 

3. Format  the cell  (serial number) to a date:  
a. Select the desired cell/cells  (B2:B3) 
b. Right  click on the selected cells  
c. Select Format  Cells  
d. Select Date 
e. Select the desired Format 
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COMBINING TEXT FROM MULTIPLE CELLS INTO ONE  
Using the & sign is the same as using the Concatenate  function, but much simpler. 

Example 
 

Below is an example in column C, of where the Main Account  and Sub Account  numbers need to be joined into one cell 
with a / to separate the Accounts. 

 

Microsoft Excel 2003/2007 process: 

1. Select the desired cell  (C2) 
2. Enter in = 
3. Select the first  cell to join (A2) 
4. Enter in & 
5. If necessary, add any additional  data that my not be found in a cell (“/”) 
6. Enter in & 
7. Select any additional  cells to join 
8. Press Enter  
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AN ALTERNATIVE TO VLOOKUP 
Using a combination of MATCH and INDEX, you can return values from an array regardless of what information is in the 
first column of the array. In a VLOOKUP, the main search criteria (for example, a sales persons name) needs to be in the 
first column of the array – using MATCH and INDEX, it doesn’t matter which column the result is in. 

Example 

You can either create the functions in two steps as in cells B20 and C20, or you can create a Nested Function as in cell 
D20. 

 

MATCH MATCH(lookup_value,lookup_array,match_type) 

Will return the row  number  of the highest value. 

Lookup_value  :   

Is the value you use to find thev alue you want in a table. Lookup_value can be a value (number, text, or 
logical value) or a cell reference to a number, text, or logical value. 

Lookup_array  :   

Is a contiguous range of cells containing possible lookup values.  

Match_type  :  

Is the number -1, 0, or 1. Match_type specifies how Microsoft Excel      matches lookup_value with values in 
lookup_array.If match_type is 0, MATCH finds the first value that is exactly equal to lookup_value. 
Lookup_array can be in any order. 

INDEX INDEX(array,row_num,column_num) 
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Returns the value  of an element in a table  or an, selected by the row and column number indexes. 

INDEX will look at an array, based  on the row  number  found in the MATCH Function, and return the 
answer  from the specified  column . 

Array  :  

Is a range of cells or an array constant. If array contains only one row or column, the corresponding 
row_num or column_num argument is optional. 

If array has more than one row and more than one column, and only row_num or column_num is used, 
INDEX returns an array of the entire row or column in array. 

Row_num  :     

Selects the row in array from which to return a value. If row_num is omitted, column_num is required. 

Column_num  :     

Selects the column in array from which to return a value. If column_num is omitted, row_num is required. 

 

Microsoft Excel 2003/2007 process: 

1. Select the desired cell  
2. Select the FX button on the Formula  bar 

 

  
 

3. Select the Lookup & Reference  category 

 

4. Select the desired Function (Match/Index) 
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5. Enter in the desired Criteria  
6. Select OK 
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 INSERTING SYMBOLS INTO THE CELL (E.G. ½) 

In can sometimes be difficult to insert a special character, such as ½ or ®, into a cell. Special characters each have their 
own unique number combination and using this can make the input of these special characters much easier. 

Example 

 

CHAR CHAR(number) 

Number  :    

Is a number between 1 and 255 specifying which character you want. The character is from the character 
set used by your computer. 

 

If you know the code number, you can enter that character any time by holding down the ALT key, and typing the 4 digit 
code number on the numeric keypad (the keys on the far right of your keyboard, do not use the "normal" number keys 
above the letter keys).  Even though character code numbers are only three digits (between 0 and 255), you must type in 
the leading zeros to ensure that you get the proper character.   For example, to enter in the British Pound sign, whose 
code is 163, hold down the ALT key, and type 0163 on the numeric keypad.  There are hundreds of special characters, 
each with their own number. A trick to finding out what the number of a special character is involves using the CHAR. 

Common Symbols  Symbol  Codes  Common Symbols  Symbol  Codes  

Euro € 0128 Registered          ® 0174 

Ellipsis         …  0133 Plus/Minus          ± 0177 

Dagger † 0134 Paragraph          ¶  0182 

Double Dagger   ‡ 0135 Degree               ° 0176 

Bullet                    • 0149 Pounds                £ 0163 

Trademark         ™ 0153 Yen                       ¥ 0165 

Cents                   ¢ 0162 Copyright            ©  0169 

 

Microsoft Excel 2003/2007 process: 
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1. Create the Symbol  list: 

a. Open a blank workbook   
b. Select cell A1 

2. Enter in the below function: 
 
 =CHAR(ROW()) 
 

 
 

a. Copy  the function down to cell A255 
b. This will display in each cell the character  whose code  number  is that cell's row number.  For example, 

the Euro  Currency  symbol will appear in cell A128, which indicates that its code number is 128 
c. If necessary, save the workbook 

3. To apply  the desired Symbol : 
a. Select the desired cell  
b. Hold down ALT  on the keyboard 
c. Using the numeric  keys on your NUMLOCK pad, enter in the desired code e.g. 0128 
d. If using a laptop , be sure to turn on your NUMLOCK pad 

You can change the font of the column to see what characters are supplied by various fonts.  Fonts with lots of useful 
symbols include Symbol, WebDings, the 3 WingDings fonts, Ref Specialty, ENCICON, Marlett, MonoType Sorts, and MS 
Reference.  Note that you may not have all these fonts on your computer. 

Alternatively, the codes of each special (and even normal) characters can be found using the Character Map  utility which 
can generally be found in the Accessories - System Tools  menu path in most Windows operating systems. 
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ADDING CRITERIA/CONDITIONS TO YOUR SUM FUNCTION 

Using the DSUM function, you can specify criteria and conditions regarding which cells should be added together. An 
alternative to using DSUM is using SUMIF. But SUMIF can't do complex criteria. 

Example 

The table contains a list of totals sales per day, showing how many hours were worked that day, the week number and the 
month. In cell H4 we have prepared a running total using the DSUM function, which takes into account a number of 
criteria that has been set up in the range A1:F2 (such as a specific day for a specific month as long as the hours in the 
work day were greater than 12 but less than 17. 

 

 

 

 

 

 

 

DSUM DSUM(database,field,criteria) 
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Database  :     

Is the range of cells that makes up the list or database. A database is a list of related data in 
which rows of related information are records, and columns of data are fields. The first row of the list 
contains labels for each column. 

Field  :     

Indicates which column is used in the function. Field can be given as text with the column label enclosed 
between double quotation marks, such as "Age" or "Yield," or as a number that represents the position of 
the column within the list: 1 for the first column, 2 for the second column, and so on. 

Criteria  :     

Is the range of cells that contains the conditions you specify. You can use any range for the criteria 
argument, as long as it includes at least one column label and at least one cell below the column label for 
specifying a condition for the column. 

Microsoft Excel 2003/2007 process:  

1. Select the desired  cell (H4) 
2. Enter in the below formula : 

 
=DSUM(A5:E1121,5,A1:F2) 
 

3. Press Enter 
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VLOOKUP  VERSUS HLOOKUP 
Depending on how your data has been setup up, you may need to either use a VLOOKUP or an HLOOKUP. 

VLOOKUP 

 

VLOOKUP(lookup_value,table_array,col_index_num,range_lookup) 

Lookup_value  :   

The value to search in the first column of the table. Lookup_value can be a value or a reference. If 
lookup_value is smaller than the smallest value in the first column of table_array, VLOOKUP returns the 
#N/A error value. 

Table_array   :  

Two or more columns of data. Use a reference to a range or a range name. The values in the first column 
of table_array are the values searched by lookup_value. These values can be text, numbers, or logical 
values. Uppercase and lowercase text are equivalent.  

Col_index_num :  

The column number in table_array from which the matching value must be returned. A col_index_num of 1 
returns the value in the first column in table_array; a col_index_num of 2 returns the value in the second 
column in table_array, and so on. If col_index_num is: 

Range_lookup :  

A logical value that specifies whether you want VLOOKUP to find an exact match or an approximate 
match: 

If TRUE or omitted, an exact or approximate match is returned. If an exact match is not found, the next 
largest value that is less than lookup_value is returned.  

If FALSE, VLOOKUP will only find an exact match.  

Searches for a value  in the first  column  of a table  array  and returns a value in the same row from 
another column in the table array.  

The V in VLOOKUP stands for vertical. Use VLOOKUP instead of HLOOKUP when your comparison 
values are located in a column to the left of the data that you want to find. 
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HLOOKUP HLOOKUP(lookup_value,table_array,row_index_num,range_lookup) 

Lookup_value : 

Is the value to be found in the first row of the table. Lookup_value can be a value, a reference, or a text 
string. 

Table_array  : 

Is a table of information in which data is looked up. Use a reference to a range or a range name. 

Row_index_num : 

Is the row number in table_array from which the matching value will be returned. A row_index_num of 1 
returns the first row value in table_array, a row_index_num of 2 returns the second row value in 
table_array, and so on. If row_index_num is less than 1, HLOOKUP returns the #VALUE! error value; if 
row_index_num is greater than the number of rows on table_array, HLOOKUP returns the #REF! error 
value. 

Range_lookup : 

Is a logical value that specifies whether you want HLOOKUP to find an exact match or an approximate 
match. If TRUE or omitted, an approximate match is returned. In other words, if an exact match is not 
found, the next largest value that is less than lookup_value is returned. If FALSE, HLOOKUP will find an 
exact match. If one is not found, the error value #N/A is returned. 
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Searches for a value  in the top  row  of a table  or an array  (array: Used to build single formulas that 
produce multiple results or that operate on a group of arguments that are arranged in rows and columns. 
An array range shares a common formula; an array constant is a group of constants used as an 
argument.) of values, and then returns a value in the same column from a row you specify in the table or 
array. Use HLOOKUP when your comparison values are located in a row across the top of a table of data, 
and you want to look down a specified number of rows. The H in HLOOKUP stands for "Horizontal." 

 

 

Microsoft Excel 2003/2007 process: 

1. Select the desired cell  
2. Select the FX button on the Formula  bar 

 

 
 

3. Select the Lookup & Reference  category 
 

 
 

4. Select the desired Function (Vlookup/Hlookup) 
5. Enter in the desired Criteria  
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6. Select OK 
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SUMIF BETWEEN WORKBOOKS  

When using the SUMIF function between  workbooks, you may get a VALUE error if the source workbook is not open. To 
work around this, use a combination of the SUM and IF functions together in an array  formula. 

Example 

The source workbook, filename Data. 

 

The workbook with the formula. 

 

 

This behavior occurs when the formula that contains the SUMIF, COUNTIF, or COUNTBLANK function refers to cells in a 
closed workbook. 

If you open the referenced workbook, the formula works correctly. 

�  Instead of using a formula that is similar to the following 
 =SUMIF([Source]Sheet1!$A$1:$A$8,"a",[Source]Sheet1!$B$1:$B$8)  

�  use the following formula:  
=SUM(IF([Source]Sheet1!$A$1:$A$8="a",[Source]Sheet1!$B$1:$B$8,0))  
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An array formula is a formula that can perform multiple calculations on one or more of the items in an array. Array 
formulas act on two or more sets of values known as array arguments. 

�  Each argument within an array must  have the same amount of rows  and columns  
�  You must  enter an array by pushing Ctrl + Shift + Enter  
�  You cannot  add the {} (braces) that surround an array yourself, pushing Ctrl + Shift + Enter  will do this for you 

 

SUMIF SUMIF(range,criteria,sum_range) 

Range :   

Is the range of cells that you want evaluated by criteria. Cells in each range must be numbers or 
names, arrays, or references that contain numbers. Blank and text values are ignored. 

Criteria  :    

Is the criteria in the form of a number, expression, or text that defines which cells will be added. For 
example, criteria can be expressed as 32, "32", ">32", or "apples". 

Sum_range  :   

Are the actual cells to add if their corresponding cells in range match criteria. If sum_range is omitted, 
the cells in range are both evaluated by criteria and added if they match criteria. 

 

Microsoft Excel 2003/2007 process: 

1. Open the workbook  that contains the source  (Data) 
2. Open the workbook  that will contain the formulae  
3. Select the desired cell  in the workbook  that will contain the formulae  (B2) 
4. Using the FX button on the Formula  Bar, locate the Sum Function 
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5. To nest in the IF Function, from the Formula  bar, in the Name Box , from the drop  down  arrow, select IF  
If the IF function does not appear, select More Functions and locate the IF Function. 

 

 
 

6. Enter in the arguments in the Logical  Test 
 

 
 
Logical_test – If cells A3:A12 in the Data workbook on Sheet 1 = East 
Value_if_true – If the above is true, sum the range B3:B12 
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Value_if_false – IF the above is not true, place 0 
 

7. Press Ctrl + Shift + Enter  
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POSITIVE AND NEGATIVE NUMBERS 
Have you ever had a column with positive and negative numbers, but would like to sum the positive and negative 
numbers separately? This can be done by using the SUMIF function. 

Example 

 

SUMIF SUMIF(range,criteria,sum_range) 

Range :   

Is the range of cells that you want evaluated by criteria. Cells in each range must 
be numbers or names, arrays, or references that contain numbers. Blank and text 
values are ignored. 

Criteria  :    

Is the criteria in the form of a number, expression, or text that defines which cells 
will be added. For example, criteria can be expressed as 32, "32", ">32", or 
"apples". 

Sum_range  :   

Are the actual cells to add if their corresponding cells in range match criteria. If 
sum_range is omitted, the cells in range are both evaluated by criteria and added 
if they match criteria. 

 
 

Microsoft Excel 2003/2007 process:   

1. To add the positive  numbers as per the example: 
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a. Select the desired  cell (B12) 
b. Enter in the below formula: 

 
 =SUMIF(A2:A10,”>0”) 
 

c. Press Enter 
2. To add the negative  numbers: 

a. Select the desired  cell (B13) 
b. Enter in the below formula:  

 
=SUMIF(A2:A10,”<0”) 
 

c. Press Enter  
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MICROSOFT EXCEL OPTIONS/TOOLS 

UPDATE FORMULAE MANUALLY  

When there are a number of formulas on a worksheet, especially if there is a lot of data to be referenced, changing one 
formula can slow the application down substantially. You have to wait a few seconds before you can proceed with your 
work while the other formulae recalculate. By using the option to manually recalculate, you can bypass this recalculation 
and avoid the delay. You can then choose to manually update your formulae. 

Microsoft Excel 2003 process:   

1. From the Menu bar, select Tools , Options  
2. Select the heading tab Calculation 

 

 
 

3. Select Manual  
4. Select OK 
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Microsoft Excel 2007 process: 

1. Select the Microsoft  Office  button 
 

 
 

2. From the bottom right, select Excel  Options  
3. Select Manual 

 

 
 

4. Select OK 
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CUSTOM AUTOFILL SERIES USING WORKING DAYS OF THE WEEK ONLY  
Every Microsoft Excel user, and every workplace, has their own specific needs and these can even extend to AutoFill 
options. With the following tip, you can customise your own ‘series’ that best meets your needs. 

Microsoft Excel 2003 process:   

1. Enter in the date in the first  cell of the range (A1) 
2. Select all cells  in the required range  including the first cell (A1:A5) 

 

 
 

3. From the Menu bar, select Edit , Fill  
4. Select Series  
5. In the Series  dialog box, check the Date and Weekday  option buttons 

 

 
 

6. Select OK 
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Microsoft Excel 2007 process:  

1. Enter the date in the first  cell in the range (A1) 
2. Select all cells  in the required range  including the first  cell (A1:A5) 

 

 
 

3. From the Home tab, in the Editing  group, select the Fill  button 
 

 
 

4. Select Series  
5. In the Series  dialog box, check the Date and Weekday  option buttons 

 

 
 

6. Select OK 
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ENSURING DATA CONFORMS TO YOUR RULES  
Making sure that the data users enter into a worksheet conforms to certain standards is difficult if you have no way of 
enforcing the rule. With Data Validation, you can: 

�  Provide users with a drop down list of choices (so they can’t input data incorrectly) 
�  Restrict entries to a specific type or size 
�  Create custom settings 

 
Example 

In the below example, you would like to ensure that the End Date is always greater  than the Start  Date.  To ensure this, 
you are going to apply Data Validation to ensure that the Date in cell B2 must be greater than the Date in cell A2. 

 
 
 
 
Microsoft Excel 2003 process:   

1. Select the range  of cells you would like to apply Data Validation  (B2:B8) 
2. From the Menu bar, select Data, Validation 
3. Enter in the below : 

 
 

4. Select OK 
5. You can now enter in the dates and if you happen to enter in a date less than the start date, you will get an error 
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Microsoft Excel 2007 process: 

1. Select the range  of cells you would like to apply Data Validation  (B2:B8) 
2. From the Data tab, in the Data Tools  group, select Data Validation 
3. Enter in the below : 

 

 
 

4. Select OK 
5. You can now enter in the dates and if you happen to enter in a date less than the start date, you will get an error 

TEXT TO COLUMNS 
There may be times when you need split one column worth of information into two or more columns. Using the Text To 
Columns  tool means that this split doesn’t have to be a manual process. 

Before : After : 

 
 

 

Microsoft Excel 2003 process:   

1. Identify the item that separates  the columns (#) 
2. Highlight  the range  of cells you would like to split  (A2:A12) 
3. From the Menu bar, select Data, Text to Columns  
4. Select Next 

 



�
�

�

 
 

5. Enter in the separator  symbol (#) 
6. Select Next  
7. Select Finish  

Microsoft Excel 2007 process:  

1. Identify the item that separates  the columns (#) 
2. Highlight  the range  of cells you would like to split  (A2:A12) 
3. From the Data tab, in the Data Tools  group, select Text to Columns  
4. Select Next 

 

 
 

5. Enter in the separator  symbol (#) 
6. Select Next  
7. Select Finish  

 

 
PASSWORD PROTECTION AND READ ONLY ACCESS 

You would like to password protect  a workbook, but still allow people to open it as read only . Using the Password To 
Modify  option makes this happen. 
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In Microsoft Excel, you can use passwords to help prevent other people from modifying Microsoft Excel workbooks. By 
using the option Password to Modify, users can open the workbook without the password, but may not be able to save 
any changes they have made. However, if they do have the password, then can save their changes. 

Microsoft Excel 2003 process: 

1. Ensure the workbook  that is being password protected is open  
2. From the Menu bar, select File, Save As 
3. From top  right  of the Save As dialog box select Tools , General  Options 

 

 
 

4. From the Save Options  dialog box, in the Password  to  modify  box, enter in the desired password  
5. The password will appear as stars (****) 
6. You will be asked to enter in the password twice  to verify  the password 

 

 
 

7. Select OK 
8. Select Save 
9. The next time the file is opened , you will be asked for a password 
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10. If the user does not  have the password , they can select Read Only  
 

 

Microsoft Excel 2007 process:  

1. Ensure the workbook  that is being password protected is open  
2. Select the Office  Button 

 

 
 

3. Select Save As 
4. From the bottom left of the Save As dialog box select Tools , General  Options 

 

 
 

5. From the Save Options  dialog box, in the Password  to  modify  box, enter in the desired password  
6. The password will appear as stars (****) 
7. You will be asked to enter in the password twice  to verify  the password 
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8. Select OK 
9. Select Save 
10. The next time the file is opened , you will be asked for a password 

 

 
 

11. If the user does not  have the password , they can select Read Only  
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OLE – OBJECT LINKING AND EMBEDDING 

POWERPOINT TO MICROSOFT EXCEL 

A Microsoft PowerPoint  presentation can be linked to a Microsoft  Excel  worksheet by using the Paste Link  option. 

You don’t need to have both Microsoft PowerPoint and Microsoft Excel open for it to update. If you make changes to the 
Microsoft Excel workbook, when you open PowerPoint, you will be asked to Update Links. 

Microsoft Excel 2003/2007 process: 

1. In Microsoft  Excel , select the desired cell/cells  
2. Right  click on the selected cell/cells 
3. Select Copy  
4. In Microsoft  PowerPoint , create a new slide 
5. Microsoft PowerPoint  2003: 

a. From the Menu bar, select Edit , Paste Special  
b. Select Paste Link  
c. In the As box, select Microsoft  Office  Excel  2003 Worksheet  Object 

 

 
 

d. Select OK 
6. Microsoft PowerPoint 2007 : 

a. From the Home tab, in the Clipboard  group, select the drop down  arrow  under Paste 
b. Select Paste Special  
c. Select Paste Link  
d. In the As box, select Microsoft Office Excel 2003 Worksheet Object 
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e. Select OK 
7. You can resize  the object  as desired 
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COPYING MICROSOFT EXCEL DATA TO MICROSOFT WORD 
You may find at times when working in Microsoft Word you need to refer to a part of a worksheet in Microsoft Excel.  It is 
possible to simply copy and paste between the two programs, but even more interesting, is that you can ensure there is a 
link back to the Microsoft Excel worksheet in the case of there being any changes. 

Microsoft Excel 2003/2007 process: 

1. From Microsoft  Excel , select the range  to be copied  to Microsoft  Word  
 

 
 

2. Right  click on the selected range , select Copy  
3. Open the desired document in Microsoft  Word  
4. Right  click on the desired area, select Paste 
5. From the bottom  right  of the Pasted  object , select the Clipboard  icon 
6. Select Keep Source Formatting and Link to Excel 

 

 
 

7. If you now make changes  to the Microsoft  Excel  worksheet, the object  in Microsoft  Word  will update  
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PASTE PICTURE LINK 
One worksheet can be used to view several individually separate and distinct areas. This can be done using the Paste  
Picture  Link option. 

There are a few options when consolidating information from multiple worksheets. The option we are looking at in this tip 
will enable you to paste the copied cells as objects (pictures). Pasting them as objects is useful as you can resize the 
objects. This tool is helpful when needing to print multiple areas of a workbook onto one worksheet or creating a 
dashboard summarizing parts of the workbook. 

Microsoft Excel 2003 process: 

1. Select the desired range  to be copied 
 

 
 

2. Right  click the selected  range, select Copy  
3. Navigate to the destination  worksheet 
4. Hold down Shift  on the keyboard  
5. From the Menu bar, select Edit , Paste Picture  Link 

 

 
 

6. Your object  (picture) will now be pasted  and can be resized  as desired 
7. Repeat  the above steps  for additional  objects 

 
Microsoft Excel 2007 process: 

1. Select the desired range  to be copied 
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2. Right  click the selected  range, select Copy  
3. Navigate to the destination  worksheet 
4. From the Home tab, in the Clipboard  group, select the down  arrow under Paste 
5. Select As Picture , Paste Picture  Link  

 

 
 
 

6. Your object  (picture) will now be pasted  and can be resized  as desired 
7. Repeat  the above steps  for additional  objects 

 

WORKSHEETS AND NAVIGATION 

HIDE FORMULA ON WORKSHEET 
By selecting Hidden  in the Protection  dialogue box, you are able to hide any formula used when you protect the 
worksheet.  
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Before : After : 

 

Microsoft Excel 2003 process:  

1. Hide the formulae : 
a. Select the cell/s  that need to have formula hidden  (B4:B6) 
b. From the Menu bar, select Format , Cells  
c. Select the heading tab Protection  
d. Select the check box Hidden 

 

 
 

e. Select OK 
2.  Protect  the worksheet : 

a. From the Menu bar, select Tools , Protection , Protect  Sheet 
b. Enter in a password  if necessary 
c. Select OK 

3. Now when selecting the range B4:B6 , the formulae  do not  show in the formula bar 
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Microsoft Excel 2007 process:  

1. Hide the formulae : 
a. Select the cell/s  that need to have formula hidden  (B4:B6) 
b. From the Home tab, in the Cells  group, select Format , Format  Cells  
c. Select the heading tab Protection  
d. Select the check box Hidden 

 

 
 

e. Select OK 
2. Protect  the worksheet : 

a. Right  click on the desired worksheet tab 
b. Select Protect  Sheet 
c. Enter in a password  if necessary 
d. Select OK 
e. Now when selecting the range B4:B6 , the formulae  do not  show in the formula bar 
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WORKSHEET NAVIGATION MADE EASY 
Often, you may have multiple worksheets in a workbook and struggle to quickly navigate to a particular worksheet. 

Microsoft Excel does provide navigation arrows on the bottom left of the screen. By simply clicking on these arrows, you 
can scroll to worksheets on the left or right. 

 

However, when you have quite a few worksheets, it can be time consuming to use these navigation arrows. 

The ‘right click method’ can speed this up. 

Microsoft Excel 2003/2007 process: 

1. Right  click on any of the navigation  arrows 
 

 
 

2. You will get a list  of all the worksheets  in the current workbook  
3. Select  the desired worksheet  
4. You will be navigated  to that worksheet 

 

Navigation Arrows 
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RANGE SELECTION MADE EASY 
It can be time consuming to use your mouse to select a range of cells, especially if it is something you need to do 
regularly (e.g. as a source for charts or PivotTables). To speed up this process, you can use Ctrl + Shift + *  

Microsoft Excel 2003/2007 process: 

1. Select any cell  in the range  of cells 
 

 
 

2. On the keyboard , press Ctrl + Shift + * 
3. The entire  list will be selected 
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Alchemex Contact Information  

Sales sales@alchemex.com 

Support support@alchemex.com  

Website www.alchemex.com 

BI Community www.alchemex.ning.com 

Online Academy www.alchemexacademy.com 

Knowledgebase www.alchemex.com 

Free Trial Software download www.alchemex.com 

Customer References www.alchemex.com 

If you know of anyone who will benefit from using A lchemex - PLEASE contact Sales.  

 

 


